Podcasting with GarageBand
The simple guide to making your own podcast

Create a podcast using technologies in the Gaskill
Learning Technologies Center:
- iMac computer
- Snowball microphone
- GarageBand software
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Introduction
If you are thinking about making a podcast or are interested in learning more about how to make a
podcast, you’ve come to the right place! This set of documentation will take you through the necessary
steps to make your own podcast with the equipment here in the Gaskill Learning Technologies Center.

What tools are used in this documentation?

The following pages will teach you how to create your own podcast using the following items:
• Snowball USB microphone
• iMac 20” computer running Mac OS X operating system
• GarageBand 3 software

For information on how to make a podcast using the Audacity software, see the alternate set of
documentation here in the Learning Technologies Center.

Who should use this documentation?

Anyone interested in making a podcast should find these instructions useful. If you are a beginner in the
realm of audio software and podcasting, this documentation will walk you through the basics step by
step. If you have experience with audio software and podcasting, you may find some new tricks to make
your podcasting experience go more smoothly. No matter your personal experience, these instructions
should guide you along your way to making a high quality podcast.

The emphasis, however, is to teach the basics. GarageBand is a fully functional audio suite that can
be used for much fancier music and audio projects. These instructions will only cover the processes of
recording, editing, and saving a podcast. For more advanced features and projects, consult Apple’s website
for more in depth GarageBand tutorials (three links below).

What information is included?

The following sections of information are included in these instructions:
• Essential podcast, hardware, and software information
• Recording audio and capturing your voice
• Editing and putting together your podcast
• Saving your podcast
• Uploading your podcast and making it available to the world

These sections have been kept to a minimum and cover the essential information and procedures that
are needed to create a podcast. Certain sections, such as the editing section, could be dozens of pages
long if these instructions were meant to be used for extensive audio manipulation and tweaking. What
you should expect is a straightforward and easy to use set of instructions that will have you successfully
creating and uploading your own podcast. For more extensive information on editing and adding to your
podcast, check out GarageBand’s included documentation or the links below.
http://www.apple.com/podcasting
http://www.apple.com/ilife/garageband/
http://www.apple.com/ilife/tutorials/garageband/index.html
http://www.zoom-in.com/tutorials/Apple/garageband/recording_a_podcast/index.php?part=1
Introduction
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Essential Podcasting Information
Thinking about creating a podcast? Want to know more about what a podcast is or why you would want
to make one? This section will answer these questions and help you get started.

What’s a podcast?

A podcast is an audio (or video) recording available for free from the internet. This audio recording can
be a talk show, a lecture, or training series that is freely available and easily produced. After interested
listeners download a podcast, they can transfer it directly to their iPod or listen to it on their computer
with a media player such as iTunes or Windows Media Player.

Why would I make a podcast?

There are hundreds of reasons for making a podcast, but one of the most popular reasons is for
entertainment. If you are interested in a particular activity and have things to say, create a podcast and
make it available to your targeted audience. Podcasts are also useful as a complement to a personal or
entertainment website. Also gaining in popularity is the use of podcasts in the academic world. Teachers,
professors, and faculty are creating podcasts for lectures, meetings, and training sessions. Students are
completing assignments and facilitating group projects using podcasts as well.
If you are an expert in a particular field, have an interest in sharing your views, or want to entertain
others, a podcast may be an excellent choice of medium to reach a large and diverse audience. Find your
niche and become an internet celebrity in your chosen field by making a podcast!

Is it easy and fun to make a podcast?

Yes! Recording and saving your own podcast is simple and fun. After learning the basics, you can dive
deeper into the pool of podcasting knowledge to tackle more advanced audio techniques. GarageBand
is an incredibly powerful application that allows you to do much more with your podcast than just
recording.

Who would listen to my podcast?

Anyone who’s interested in your topic and is aware of its existence can download and enjoy your
podcast. Now it’s easier than ever to reach your audience by utilizing the iTunes Music Store and
advertising it on your own website. The small file size and transportability of a podcast makes it easy for
an interested listener to obtain and listen to the podcast. If your podcast is about sports, an avid sports
fan may download and listen to the podcast. If your podcast is about photography, expert and beginner
photographers might be interested in hearing what you have to say, especially if you are an expert in the
field.

How do I make my podcast available to the world?

There are dozens of ways to share your podcast with thousands of interested listeners. If you have your
own website, you can upload the audio file to your web space. Since you are a Miami student, you can
also create a publicly available folder in your disk space and make it available from the M drive. You can
also put it up for download on the iTunes music store. If you want to make it available for free on iTunes,
you can read the instructions on Apple’s website on how to get it listed in the iTunes Music Store and
how to have it automatically include your next podcasts in the listings. This topic is covered in more
detail on page 15.
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Getting to Know the Equipment
Making a podcast with few technical troubles is only possible with knowledge of the equipment and the
proper configuration. This section introduces you to the podcasting equipment available in the Gaskill
Learning Technologies Center, and it prepares you for your podcasting adventure.

The Hardware

Not many pieces of hardware are required to record your own podcast.
• iMac computer
• Snowball USB microphone

The microphone, in conjunction with the GarageBand software, is used to record your voice. The iMac
computer and GarageBand software take care of the rest.
iMac Computer
The 20-inch iMac computers in the Gaskill Learning Technologies Center are new and improved over
previous models with faster speeds and more capabilities. The only important
parts on the iMac concerning podcasting are the three USB 2.0 ports located
on the back of the system. The Snowball microphone must be plugged in to one
of these USB ports to function. The iMac does have an internal microphone
enabled by default, but the Snowball microphone is much higher quality than the
basic internal microphone on the iMac.
Snowball Microphone
The Snowball is a high quality microphone that connects to the computer via a
USB cable. This is the device that you talk into to record your podcast.

When properly connected to the computer, the Snowball’s red LED light at the top
will be illuminated. When recording your voice with the microphone, make sure the
front of the microphone with the Blue logo is facing you to get a clear recording.

The Software

The software that you will be using with these
instructions is GarageBand 3. GarageBand is software
created by Apple and is available in Mac OS X as part
of the iLife suite. GarageBand is a fully functional
audio studio capable of creating music tracks from
scratch, but we will only focus on the basics for
creating a podcast.
iTunes is used briefly to convert an audio file to MP3.
No other specialized software applications are used in
these instructions.

Getting to Know the Equipment
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GarageBand Overview
Before you get started with your podcasting project, it is important to learn the interface and basic
overview of the GarageBand software. If you are familiar with audio editing applications, the interface
may look familiar to you. But if you are just starting and have not had experience with software like
GarageBand, the interface may seem intimidating. Don’t worry. The interface is easy to learn, and you
will be a master in no time.

It is important to realize that GarageBand is not a media player such as iTunes. GarageBand’s main
function is to create audio projects from scratch - not play music back. Professional audio mixers use
this software for creating and editing their own songs. But the beauty of GarageBand is that anyone can
learn to use it. It can be used as a professional tool, but it is also a wonderful tool for the everyday user.
Quick Tip: Hover over any control or button in the GarageBand workspace to get a tooltip describing
its name and function. These tooltips will be very helpful for learning the interface.
The GarageBand interface is shown below. Titles and descriptions are included on the next page.
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1 - Track Header and Mixer. The track header displays the instrument name, instrument icon, and a
5-button toolbar with various options including the ability to enable/disable recording for the track and
mute the sound of the track. The mixer allows you to lower or turn up the volume of the track by sliding
the volume bar. It also gives you the ability to duck or unduck the track and set the track pan position.
2 - Beat Ruler. This is where you can see how much time has been recorded in the project. In this area,
you can move the playhead to a specific point on the timeline by dragging it.
3 - Timeline. This is where the meat and potatoes of the project are. This is where you build, arrange,
rearrange, edit, delete, and place audio recordings into your podcast project. In the timeline it is easy to
place specific portions of audio exactly where you want them.
4 - Track Info and Media Browser. Track information and the ability to preview your podcast is in this
area. The media browser allows you to find audio clips on your computer to add to the project.
5 - Toolbar for adding tracks, viewing loop browser, and viewing track editor. The
button allows
you to create a new track. The
button shows or hides the loop browser, which allows you to add
sound effects and jingles to the podcast. The
button shows or hides the track editor, which allows
you to tweak and modify a section of a track.
6 - Zoom Level. Drag the bar to the left to decrease the zoom level. This allows you to see more of the
timeline. Drag the bar to the right to decrease the time shown. This allows you to see less time in the
window but with a more detailed view.
7 - Main toolbar for recording and playback. This toolbar is used extensively while creating a podcast.
The
button starts and stops recording. The
button puts the playhead at the beginning of the
podcast. The
button steps back one increment. The
button starts to play the project and also
serves as the stop button. The
button steps forward one increment. The
button turns the cycle
region on or off.
8 - Track Editor / Loop Browser. The track editor button allows you to modify a track’s pitch and
tuning. If the loop browser button is selected, the loop browser will be displayed. The loop browser
allows you to find audio clips that are available for your podcast. There are more details on the use of this
button on the next page.
9 - Clock. The clock displays the time and specific location of your spot in the audio project.
10 - Volume. Drag the circle on the volume bar to lower or raise the volume. The two bars above the
volume bar show the volume of the recording is.
11 - Toolbar for displaying Track Info and Media Browser. If you click the
button, it will show
or hide the track information display on the right side of the screen. If you click the
button, it will
show or hide the media browser.

GarageBand Overview
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Creating a New Podcast Episode
Now it is time to begin your podcasting journey! Since GarageBand is software created by Apple, it is
no surprise that GarageBand includes special features that are only used for podcasting. However, to get
these special features into your project, you must create a new podcast project.

Creating a new project
1.

Open GarageBand by clicking the GarageBand icon ( ) in the dock at the bottom of
the screen. Wait for a few seconds for GarageBand to load.
• If GarageBand automatically loads a project and opens to the main screen, choose the
File menu and click Close. The new project window will appear.

2.

The new project window will appear with four options. Choose the second option
labeled New Podcast Episode by clicking on the icon to the left of the text. A save dialog
box will appear.

3.

Type in a name for your project where it says Save As. Browse to the location you want
to save the project and click the Create button.

GarageBand should open to the main screen. Now you can start recording your podcast!
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Recording Your Voice
Now it’s time for the fun part! It’s time to record your voice and put together your podcast. Be sure to
check that the Snowball microphone is connected to the computer and that the red LED light is lit on
the Snowball. If you experience troubles while recording, see pages 16 and 17 to make sure the Snowball
is setup and configured properly.

Recording with the Snowball microphone

You have everything ready to go, you have a plan for what you are going to say, and now it’s just you and
the microphone. The following section explains how to record your voice.
1.

Open GarageBand from the dock or Applications folder and load your podcast project.

2.

Under the Track Header, find the track named Male Voice or Female Voice. Select the
appropriate track for you by clicking the icon to the left of the text.

Everything in GarageBand is now ready for recording.
3.

Bring the Snowball microphone to a close distance (5-10 inches from your mouth) and
prepare to speak into the microphone. When you are ready, click the main Record button
located below the timeline and adjacent to the main playback controls. Speak into the
Snowball to begin recording your podcast.

• The playhead (the small down arrow in the Beat Ruler above the timeline) will begin
moving, and a recording will be created in the track that you selected. As you talk, the
graphical representation of your voice reacts to the level of your voice to indicate the
decibel level you are recording. You can keep track of how long the recording is by
viewing the clock next to the main playback controls (seen on the above image as the
blue digital readout) or looking at the Beat Ruler located above the timeline.
4.

When you are ready to stop recording, click the Record button again. Recording is now
turned off.

5.

Click the Play button to stop the playhead from moving.

• To move back to the beginning of the project to hear what you recorded, click the
button immediately to the right of the record button or drag the playhead back to the
beginning. Press Play to hear your recording and press Play again to stop playback.

Now you know how to create a recording using the Snowball microphone in GarageBand. To learn how
to modify, delete, edit, and add effects to your recording - continue reading.
Recording Your Voice

7

Putting it All Together
As you work on your podcast project, you will no doubt make some mistakes. You may forget what you
were saying or you may just mess up a line. But this isn’t a live broadcast, so you can go back and fix
everything that you may have messed up! You may also want to liven up your podcast by adding jingles
and sounds in the background.
Quick Tip: Don’t forget to save your podcast project as you work! Nothing’s worse than losing all
of your hard work. Suggestion: save it to your Miami-provided disk space. Also, if a message appears
asking you if you want to include an iLife preview, choose no.

Creating another recording on the same track

Unless you are a perfect performer, you will need to restart your recording or make a separate recording
on the same track. The following section describes how to create another recording and connect it with
your previous recordings. It assumes that you have created a new project and recorded your voice into the
male or female voice track.
1.

Click on the track’s icon to make it active.

2.

In the timeline, find the end of the previous recording. Drag the playhead to the very
end of this recording or click in the beat ruler to move the playhead to the location.

• IMPORTANT: Put the playhead in a location away from an already recorded
recording. If you start to record over a recording on the same track, the previous
recording will be overwritten. It is possible to move the newly created recording and
recover overwritten recordings, but it is best to avoid this entirely by ensuring that you
leave enough empty space to make your new recording.
Quick Tip: If you overwrite part of a previous recording, drag the new recording to another track
such as Jingles. Go back to the overwritten recording, point your cursor to the end of the track that was
overwritten, and drag it back to its original length to recover the audio. You can then move the new
recording back to the appropriate track.
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3.

Click the record button and begin to speak. Click the record button again to stop
recording when you are finished. A new recording will be created on the same track.

Now you can move each recording separately by clicking and dragging the recording
(the purple sections) left or right on the timeline. You can drag the recording to the
beginning of the timeline, after another recording, or between multiple recordings. You
can also drag these to other tracks, but this is not necessary for podcasting purposes.

Deleting a portion of a recording

Everyone makes mistakes, but you don’t have to let your audience listen to yours. Did you sneeze,
cough, or stutter during a recording? Edit it out. There are two main methods for deleting a section of a
recording: using the track editor and using the cut command, or using the split method.
Using the Track Editor / Cut method
This method deletes a section of a recording by clicking and dragging over a certain portion and using
the cut option.
1.

Select the recording by clicking on it in the timeline. The purple section is highlighted.

2.

Show the track editor if it is not already being shown by clicking the View/Hide Track
Editor button located to the left of the playback controls below the timeline and track
names.

The track editor will appear at the bottom of the window.

Putting it All Together
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3.

Find the section of the recording that you want to delete. In the track editor section at
the bottom of the window, click and drag your mouse cursor (in the body of the Beat
Ruler) from the beginning to the end of the section you want to delete.

4.

With the section of the recording highlighted, select the Edit menu and click Cut. The
section is now removed from the timeline and the original recording is split into two
recordings.

5.

In the timeline above the track editor, click and drag the second section until it touches
the right edge of the first section. This will delete the dead space where the deleted
portion used to be.

Putting it All Together

Using the Split method
The split method works by splitting the recording into multiple pieces and deleting the unwanted
section.
1.

Select the recording by clicking on it in the timeline. The purple section is highlighted.

2.

Find the beginning of the section of the recording that you want to delete. Drag the
playhead to this position.

3.

Select the Edit menu and click Split. The recording will be split into two recordings.

4.

Find the end of the section that you want to delete. Drag the playhead to this position.

5.

Select the Edit menu and click Split once again. You have now isolated the portion of
the recording that you want to delete.

6.

Click into an empty gray area of the timeline to deselect the entire track.

7.

Click the isolated section that you want to delete to select it.

8.

Press the delete key (located above the \ key) to remove it from the project.

Putting it All Together
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Joining separate recordings

When you have separate recordings on the same track, it may be easier to join them together to reduce
clutter and make it easier to move a single recording at once.
1.

Click and drag the sections you want to join next to each other on the timeline to
eliminate the dead space in between.

2.

Click on the first section, hold down the Shift key, and click the second section. If you
have more than two sections that you want to join together, continue to hold shift and
click on the rest of the sections to highlight them all.

3.

Release the shift key and select the Edit menu. Click Join from the drop-down menu.
The two separate recordings will be joined into one recording.

Adding loops and jingles

For some extra touches, you might want to add some background audio clips or fun audio effects. This is
possible using the available loop recordings included with GarageBand.
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1.

Show the Loop Browser by clicking on the View / Hide Loop Browser button located to
the left of the playback controls below the timeline and track names.

2.

Browse through the menus and click on a selection to preview the available loops.

Putting it All Together

3.

When you find a selection that you want to include in your podcast, click and drag it to
the Jingles track.

Ducking and unducking a loop
You will find that the sounds in the Jingles track are lowered in volume automatically when your
voice is being played in the Male or Female voice track. When there is no recording in the Male
or Female voice track, the jingle will be played at full volume. This helps automate the process of
including background music and sounds to your podcast.

If you would prefer the audio in the Jingles track to be played at full volume, unduck the track by
clicking the up arrow in the track mixer.

Putting it All Together
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Exporting and Saving Your Podcast
You’ve finally completed your podcast, and you’re happy with what you’ve created. Now you want to put
it in an audio format that the world can listen to on their iPods or computers.

Saving your podcast to an audio file

Saving your podcast to an audio file is extremely easy with GarageBand. However, the software is not
very flexible and does not let you choose what kind of file to save. This will be addressed in the next
section, but for now you can read on to see how to save your podcast to an audio file.
1.

Select the Share menu in the menu bar and click Export Podcast to Disk. A dialog box
will appear asking you where to save the file.

2.

Type a name for your podcast file and choose a location to save your file.

3.

Click Save. GarageBand will save the .m4a file to the location that you chose.

Converting the M4A file to MP3 using iTunes

The file that GarageBand saves is an M4A file - not the one most people know and love: MP3. Most
media players and all iPods play the M4A files perfectly well. However, you may want to convert your
podcast into an MP3 file to make sure none of your listeners have compatibility issues. There are many
programs available that will convert audio files from one type to another. Apple’s iTunes is used below.
1.

Browse to the location of your podcast audio file that is currently saved in M4A format.

2.

Double-click on the file to open it in iTunes. The file will start to play. Press the pause
button to stop the podcast in the upper-left hand corner of the window.

3.

Your podcast should show up in the main window area of iTunes. Select your podcast by
clicking it.

4.

While your podcast is selected, choose the Advanced menu from the menu bar. Click the
option labeled Convert Selection to MP3.
• NOTE: If the menu option says something other than MP3, do the following: Choose
the iTunes button in the menu bar at the top-left corner of the screen and click the
Preferences option. In the preferences, click the button labeled Advanced. Then click the
tab Importing. Where it says Import Using: choose MP3 Encoder from the drop-down
menu. Exit iTunes preferences and repeat step 4. The menu option should now read
Convert Selection to MP3.

iTunes will now convert the M4A file to an MP3 file. When it is finished, it will begin to
play the podcast again. Press the pause button to stop the podcast if you would like.
5.
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With the file selected, choose the File menu and select Show in Finder. This will bring
you to the folder where the MP3 file is stored. You can now save it to another location.

Exporting and Saving Your Podcast

Making Your Podcast Available to the World
You have created your podcast and are ready to show the world what you have done. But how exactly do
you make your file available to everyone on the internet? There are three main ways to accomplish this.
1. Create a world-wide readable folder on your Miami disk space (M drive).
2. Upload your podcast to your own website disk space and advertise it on your site.
3. Use the iTunes store to freely distribute your podcast.

Creating a world-wide readable folder on your Miami disk space
Miami offers every student a 100MB of disk space on Miami servers for personal use. Most students
use this every day to save project files or backup personal files. Miami also allows you to use this space to
create your own website by making a publicly readable folder.
To make a publicly available website, visit the following link:
http://www.units.muohio.edu/mcs/univapps/netapps/www/novell/wwwsetup.htm

This website will guide you through a simple process to create a publicly available folder that you can use
to distribute your podcast. Once you are through the process, a folder named public.www will be created
in your disk space. You can now upload files, including your podcast MP3 or M4A files, into this folder.
You can upload files by logging into UDSmount on the Desktop and opening your M drive or selecting
netDisk while logged in to the MyMiami website.
Once you upload your file into the public.www folder, you can now link people to the file. In the
following example, replace uniqueID with your Miami unique ID (your username for almost everything
related to Miami). If your file is called MyFirstPodcast.mp3, the link will become:
http://www.users.muohio.edu/uniqueID/MyFirstPodcast.mp3
Now you can post about it on your favorite sites, message your friends, send out emails, and spread the
word. Link everyone to your podcast, and they will be able to download and listen to it.

Uploading your podcast to your own website disk space

You may already have your own website where you want to upload your podcast. Your web host should
be able to instruct you on how to upload files to your web space. You will probably need a username,
password, and FTP program. Once you have uploaded the podcast, you can link your friends and
visitors to the file and let everyone listen to it!

Using the iTunes store to freely distribute your podcast

iTunes makes it easy for listeners to download and subscribe to podcasts. Subscribing to a podcast means
that listeners will automatically be notified whenever a new podcast is put on the web by a certain author.
Utilizing the iTunes store can make your podcast available to thousands of people.
The process of getting your podcast into the iTunes store is rather complex and is beyond the scope of
this documentation. Information on how to do this can be found online at Apple’s site:
http://www.apple.com/itunes/store/podcaststechspecs.html

Making Your Podcast Available to the World
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Configuring the Snowball Microphone
It is important to make sure that the Snowball microphone is properly connected to the computer and
properly configured in Mac OS X and GarageBand. These quick checks will prevent annoying problems
and frustration from occurring while trying to record your podcast.

Hardware Setup

The Snowball microphone is a USB microphone that should
be connected to the iMac directly with a USB cable. Since this
should already be hooked up correctly, make a quick spot check
to make sure the microphone is connected to a USB port on the
back of the computer.

If the Snowball is connected properly to the computer, the red LED light on the front of the Snowball
should be illuminated. This indicates that the Snowball is powered on and ready to go. The Snowball
does not have an on or off button. The Snowball will have power as long as it is plugged into the
computer.

Software Configuration

To save headaches and frustration from microphone problems, it is important to make sure that the
software is configured correctly to receive input from the Snowball microphone. The two areas that need
to be checked for correct configurations are the Mac OS X sound system preferences and GarageBand
audio preferences.
Configuring Mac OS X
Check to see if Mac OS X is correctly configured to use the Snowball microphone.
1.

Click the Apple logo in the menu bar at the top-left corner of the screen. The Apple
menu opens.

2.

Click System Preferences from the menu. The System Preferences window opens.

3.

Under the Hardware section, click the icon labeled Sound.

The Sound Preferences window opens.
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Configuring the Snowball Microphone

5.

Under Choose a device for sound input, find Blue Snowball under the column labeled Name.
Click on Blue Snowball to select it.
• Here you can set the input volume for the microphone. The Snowball is sensitive
and may require a very low setting. Chances are the volume level is already at an
appropriate default level.

This completes the Mac OS X Snowball configuration. Exit System Preferences by
clicking the red ‘X’ circle in the top-left corner of the window.
Configuring GarageBand
Check to see if GarageBand is properly configured to use the Snowball microphone for recording input.
1.

Open GarageBand by double-clicking the GarageBand icon in the dock at the bottom
of the OS X desktop, or double-clicking the GarageBand icon in the Applications folder.
• IMPORTANT: You must have a project loaded into GarageBand to get to the
preferences menu. Open a new project or an existing project to continue. See page 6 for
information on how to create a new project.

2.

Once GarageBand loads your project, click the GarageBand menu in the menu bar.

3.

Click Preferences in the drop-down menu. The GarageBand Preferences will be shown.

4.

Click the icon labeled Audio/MIDI, the second icon from the left at the top.

5.

Next to Audio Input, choose Blue Snowball from the drop-down list.

• Alternatively, you can get to the preferences by pressing the Apple key + Comma key.

This completes the GarageBand configuration. Exit the GarageBand Preferences by
clicking the red ‘X’ in the top-left corner of the window.

Configuring the Snowball Microphone
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